� TOC \o �1. Introductions	� GOTOBUTTON _Toc408367645  � PAGEREF _Toc408367645 �
3
��

Classes of  Objects	� GOTOBUTTON _Toc408367646  � PAGEREF _Toc408367646 �
4
��

General Page, Overlap Page, and Common Page	� GOTOBUTTON _Toc408367647  � PAGEREF _Toc408367647 �
4
��

Limitation of No. of Objects	� GOTOBUTTON _Toc408367648  � PAGEREF _Toc408367648 �
6
��

Dynamic Data Management	� GOTOBUTTON _Toc408367649  � PAGEREF _Toc408367649 �
7
��

Design Screen by Tool Box	� GOTOBUTTON _Toc408367650  � PAGEREF _Toc408367650 �
7
��

2. File Management	� GOTOBUTTON _Toc408367651  � PAGEREF _Toc408367651 �
8
��

�EMBED MSDraw   \* mergeformat��� New  [Ctrl+N]	� GOTOBUTTON _Toc408367652  � PAGEREF _Toc408367652 �
8
��

� Open  [Ctrl+O]	� GOTOBUTTON _Toc408367653  � PAGEREF _Toc408367653 �
9
��

� Save  [Ctrl+S]	� GOTOBUTTON _Toc408367654  � PAGEREF _Toc408367654 �
9
��

Save As	� GOTOBUTTON _Toc408367655  � PAGEREF _Toc408367655 �
10
��

Print Options	� GOTOBUTTON _Toc408367656  � PAGEREF _Toc408367656 �
10
��

� Print	� GOTOBUTTON _Toc408367657  � PAGEREF _Toc408367657 �
11
��

Print Preview	� GOTOBUTTON _Toc408367658  � PAGEREF _Toc408367658 �
11
��

Print Setup	� GOTOBUTTON _Toc408367659  � PAGEREF _Toc408367659 �
11
��

Exit	� GOTOBUTTON _Toc408367660  � PAGEREF _Toc408367660 �
11
��

3. Object Design	� GOTOBUTTON _Toc408367661  � PAGEREF _Toc408367661 �
12
��

Object menu	� GOTOBUTTON _Toc408367662  � PAGEREF _Toc408367662 �
12
��

Tool box	� GOTOBUTTON _Toc408367663  � PAGEREF _Toc408367663 �
12
��

� Select Object	� GOTOBUTTON _Toc408367664  � PAGEREF _Toc408367664 �
13
��

� Line	� GOTOBUTTON _Toc408367665  � PAGEREF _Toc408367665 �
14
��

� Rectangle	� GOTOBUTTON _Toc408367666  � PAGEREF _Toc408367666 �
14
��

� Circle	� GOTOBUTTON _Toc408367667  � PAGEREF _Toc408367667 �
15
��

� Text	� GOTOBUTTON _Toc408367668  � PAGEREF _Toc408367668 �
15
��

� Graphics	� GOTOBUTTON _Toc408367669  � PAGEREF _Toc408367669 �
17
��

� Date  (for MT300 only)	� GOTOBUTTON _Toc408367670  � PAGEREF _Toc408367670 �
19
��

� Time (for MT300 only)	� GOTOBUTTON _Toc408367671  � PAGEREF _Toc408367671 �
19
��

� Lamp (for MT300 only)	� GOTOBUTTON _Toc408367672  � PAGEREF _Toc408367672 �
20
��

� Data	� GOTOBUTTON _Toc408367673  � PAGEREF _Toc408367673 �
22
��

� Animation	� GOTOBUTTON _Toc408367674  � PAGEREF _Toc408367674 �
24
��

� Push Button	� GOTOBUTTON _Toc408367675  � PAGEREF _Toc408367675 �
25
��

� Screen Button	� GOTOBUTTON _Toc408367676  � PAGEREF _Toc408367676 �
27
��

� File Button (for MT300 only)	� GOTOBUTTON _Toc408367677  � PAGEREF _Toc408367677 �
30
��

� Hardcopy Button (for MT300 only)	� GOTOBUTTON _Toc408367678  � PAGEREF _Toc408367678 �
31
��

� PLC Control	� GOTOBUTTON _Toc408367679  � PAGEREF _Toc408367679 �
32
��

� Message	� GOTOBUTTON _Toc408367680  � PAGEREF _Toc408367680 �
39
��

4. Edit	� GOTOBUTTON _Toc408367681  � PAGEREF _Toc408367681 �
41
��

� Format	� GOTOBUTTON _Toc408367682  � PAGEREF _Toc408367682 �
41
��

�Temporary File (for MT300 only)	� GOTOBUTTON _Toc408367683  � PAGEREF _Toc408367683 �
48
��

5. Tool	� GOTOBUTTON _Toc408367684  � PAGEREF _Toc408367684 �
49
��

� Overlap	� GOTOBUTTON _Toc408367685  � PAGEREF _Toc408367685 �
49
��

� Copy	� GOTOBUTTON _Toc408367686  � PAGEREF _Toc408367686 �
50
��

� Cut	� GOTOBUTTON _Toc408367687  � PAGEREF _Toc408367687 �
51
��

Directories	� GOTOBUTTON _Toc408367688  � PAGEREF _Toc408367688 �
52
��

6. View	� GOTOBUTTON _Toc408367689  � PAGEREF _Toc408367689 �
53
��

100 ﹪ and 75 ﹪	� GOTOBUTTON _Toc408367690  � PAGEREF _Toc408367690 �
53
��

Tool Bar	� GOTOBUTTON _Toc408367691  � PAGEREF _Toc408367691 �
53
��

Status Bar	� GOTOBUTTON _Toc408367692  � PAGEREF _Toc408367692 �
54
��

Tool Box	� GOTOBUTTON _Toc408367693  � PAGEREF _Toc408367693 �
54
��

Graphic Files	� GOTOBUTTON _Toc408367694  � PAGEREF _Toc408367694 �
54
��

Align Grid	� GOTOBUTTON _Toc408367695  � PAGEREF _Toc408367695 �
55
��

Grid	� GOTOBUTTON _Toc408367696  � PAGEREF _Toc408367696 �
55
��

Object Contents	� GOTOBUTTON _Toc408367697  � PAGEREF _Toc408367697 �
55
��

Select Page No.	� GOTOBUTTON _Toc408367698  � PAGEREF _Toc408367698 �
56
��

7. PLC device address naming style	� GOTOBUTTON _Toc408367699  � PAGEREF _Toc408367699 �
57
��

8. Download	� GOTOBUTTON _Toc408367700  � PAGEREF _Toc408367700 �
60
��

Appendix A :  Installation of the EasyBuilder software	� GOTOBUTTON _Toc408367701  � PAGEREF _Toc408367701 �
62
��

Appendix B : Examples to build objects	� GOTOBUTTON _Toc408367702  � PAGEREF _Toc408367702 �
63
��

Create an ON/OFF push button	� GOTOBUTTON _Toc408367703  � PAGEREF _Toc408367703 �
63
��

Create a numeric data display	� GOTOBUTTON _Toc408367704  � PAGEREF _Toc408367704 �
65
��

Appendix C : Difference between	� GOTOBUTTON _Toc408367705  � PAGEREF _Toc408367705 �
67
��

MT200,MT250 and MT300	� GOTOBUTTON _Toc408367706  � PAGEREF _Toc408367706 �
67
��

�1. Introductions

The EasyBuilder is a graphic editor software to configure the EasyView PLC Operator Panel . The EasyBuilder Screen Editor Software takes advantage of  the Microsoft's Windows graphical interface, and object oriented scheme. It offers fast and intuitive configuration, simplifies application design and reduces development costs. It makes configuration a snap, no  programming. You can draw the graphics by familiar graphics drawing tool on Windows such as Designer,Coredraw, Autocad and ,etc., then save the graphics in BMP format, or cut the graphics and use PANBRUSH to convert it to BMP format. In the EasyBuilder you can import any graphics in BMP format to customize your application.

�

Fig.1-1 EasyBuilder Screen Editor

Each project can accomodate 256 pages at maximum. Each page is constructed with several different object as shown in fig. 1-2.

� EMBED PBrush  ���

Fig 1-2 :  objects of the screen 

Classes of  Objects

 In generally, objects can be classified into five classes : static display object, real time clock object, dynamic display object, touch control object, and PLC object.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Static Display Object :

Objects in this class consists of background graphics and texts. The static display objects include line, circle, rectangle, text and bit-map graphics objects.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Real Time Clock Object :

Objects in this class display the MT300's internal clock data. The real time clock objects include time and date objects. 

�SYMBOL 183 \f "Symbol" \s 10 \h�	Dynamic Display Object :

Objects in this class display PLC relay or register data periodically. The dynamic display objects include data, animation, and lamp objects.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Touch Control Object :

Objects in this class define a rectangular region on the screen. The rectangular region, when touched, activates a specific operation such as write data (to the PLC's registers), switch screen, hardcopy, and file transport. The touch control objects include push button, screen button, hardcopy button and file button objects.

�SYMBOL 183 \f "Symbol" \s 10 \h�	PLC Object :

Objects in this class define a PLC control device. The PLC control device, when triggered, activates a specific operation such as switch screen, hardcopy, file transport and back light control. The PLC objects include PLC control and message objects.



General Page, Overlap Page, and Common Page

All the 256 pages are numbered from 0 to 255. They also can be classified into three classes: the general page, the overlap page, and the common page. The page 0 is always used as the common page instead of a general page. PLC control objects and message objects have to be defined in the common page except other special consideration. The page 0 is vested with a special characteristic. Any objects defined in the page 0 are always effective regardless the screen switches to which page,  For example: A PLC control object to activate screen switch is defined in the page 0, the control device is M10 relay.  Then, whichever page is displayed on the screen,  the screen switches to the page designated by the PLC control object when the M10 relay gets ON.



�EMBED MSDraw   \* mergeformat���

Fig. 1-3 : the general page, overlap page and common page



When a general page (page 1-255) is called up, the EasyView displays  all the objects defined in the page. It also displays all the objects defined in its overlap page if overlap option is set for the page. All touch control objects (such as push button, screen button, hardcopy button and file transport button) defined in the overlap page are also effective. Besides, if there are any display objects in the page 0, they will also be displayed on the screen, and all touch control objects defined in the page 0 are effective too.



Each page has one overlap page at most. An overlap page is usually configured common use background graphics, tables, titles, and live data. Every page can be set as the overlap page of other page except the page 0.



A PLC control object gets effective in three situations. The first situation is that it is defined in the current page, the second is that it is defined in the overlap page, the third is that it is defined in the common page(0). The third one is the most common usage.



 When you need the same PLC control operation in several different pages, you can use the first way to define these PLC objects in each page. In another way, you can define these duplicate objects in an general page then use Overlap option to set this page as the overlap page for those need the same PLC control operations.  If you need the same PLC control actions in every page, you just have to put these PLC control objects in the common page. 



 By the way of defining objects in an overlap page or in the common page, it helps you save the time and memory to duplicate objects in each individual page.



On the screen of EasyBuilder , it displays all the objects at current  page and its overlap page concurrently. To distinguish objects in the overlap page from those in the current page, the EasyBuilder displays those objects in overlap page in gray color. They are not allowed to move, delete, modify, and copy in the current page. However, after the screen data has been loaded into the EasyView, there is no way to distinguish which belongs to the general page or  the overlap page.



�EMBED MSDraw   \* mergeformat���

Fig. 1-4 difference between objects in overlap page and in current page



Limitation of No. of Objects

The EasyBuilder does not limit the amount of static display objects in a page. However, it limits the total amount of  dynamic objects (including dynamic display objects, touch control objects, and PLC  objects ) on the screen as 256 at maximum. It also limits to access  PLC data block  not greater than 64. Each data block mentioned here is composed of 30 continuous registers at maximum. The above limitation includes objects belongs to the general page, the overlap page, and the common page. For example: there are 30 data objects defined in the overlap page and 10 data objects defined in the common page. Then the maximum number of dynamic objects that can be defined in the current page is 216. If you exceed the above limitation on the page, the EasyView will display the messages "The number of dynamic objects exceeds 256" or "The number of PLC data blocks exceed 64" when it switches to the page. 

�Dynamic Data Management

The EasyView uses dynamic data access approach to manage PLC data. You can put a lot of  data objects that access PLC relays or registers on 255 pages, But the EasyView only access those PLC data related to the current page. The system automatically compiles a variable scan list for each display page optimized for PLC communication.



By the dynamic data management approach, The EasyView collects all continuous PLC registers to be accessed in a command automatically. It improves the communication efficiency and accelerates the screen update speed. 



Accordingly, we recommend you to keep the continuity of PLC data in each page. Take for an examples, if registers D0, D1, D2, D4, D5 (not continuous) is accessed in a page, it's better off to rearrange them to access D0, D1, D2, D3, D4 (continuous) instead.



Design Screen by Tool Box

Configuration of the EasyView is easy. To setup objects, select an icon from toolbox, click on the right position of the screen, or drag the boundary of objects, the dialog box will appear, then fill in the blank to complete setup process of an object. It's a clean, simple and consistent process.



After complete the screen edit, connect the EasyView to COM1 or COM2 of your PC, execute load function, it will transfer your screen data to flash memory of the EasyView directly.



�EMBED MSDraw   \* mergeformat���

Fig.1-5 EasyBuilder tool box��2. File Management

In the EasyBuilder, it provides some simple operations of file in File menu. Some options frequently used in file menu have functional icons at the tool bar to provide a fast way to call up.



File menu

�

Fig. 2-1 : file menu

The File menu includes all operations pertaining to the creation, loading, saving and printing of project files. The menu includes the following options : 

�SYMBOL 183 \f "Symbol" \s 10 \h�	New : to create a new working project.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Open : to open an existing project as the working project.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Save : to save the working project with its original name.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Save As : to save the working  project with a new name.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Print Options : to select type of data to be printed.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Print : to print out the selected data

�SYMBOL 183 \f "Symbol" \s 10 \h�	Print Preview : to display the draft  on the screen before printing

�SYMBOL 183 \f "Symbol" \s 10 \h�	Print Setup : to configure the printer

�SYMBOL 183 \f "Symbol" \s 10 \h�	Exit : to exit the EasyBuilder





�EMBED MSDraw   \* mergeformat��� New  [Ctrl+N]

This option enables you to create a new project. You are requested to assign a name of the project. Each project consists of  five files. All these files use the same name and their extension names are different. These extension names are .prj, .tbl, .txt, .fon, and .fle. The file with extension name .prj is a dominating file. If the name you assigned is as same as an existing project, the EasyBuilder gives you a warning message and asks you about whether you want to replace it or not.



�� Open  [Ctrl+O]

Use this option to open an existing project as the working project. The .prj , .tbl and related .bmp files must exist, otherwise it will fail to open the project file.



� Save  [Ctrl+S] 	

This option saves the working project with its original project name and compiles the screen data to generate the download files. It translates the original data into another format accepted by the EasyView. 

�EMBED MSDraw  \* mergeformat \s���

After finishing the save operation, it displays a "Memory Utilization" window to report the memory usage information of EasyView. It is depicted as fig.2-2. The memory utilization are participated into four category. Under each category, the maximum capacity, No. of usage, and free percentages are listed.



�

Fig. 2-2 : memory utilization



�SYMBOL 183 \f "Symbol" \s 10 \h�	Objects  

The maximum number of objects is 5368. The EasyBuilder  will not accept to add any new object when there are no free objects.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Pointers 

Every text ,graphic or message objects need a pointer. There are 1792 pointers in total. After all these pointers are allocated, The EasyBuilder  will not accept to add any text, graphic or message objects.

��SYMBOL 183 \f "Symbol" \s 10 \h�	Strings 

The maximum memory space of text strings are 52K bytes. When these space is not enough to store all the text strings, EasyBuilder displays a warning message after the "SAVE" operation.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Graphics

There are 416K bytes to store font/graphic data of the bit-mapped pattern. When the space is not enough., the EasyBuilder  displays a warning message on the screen after the "SAVE" operation.  



Save As    

Use this option to save the working project as a new project name. If you want to save the modified screen data without losing original data, you can use this option to save the modified data as a new project. As same as the Save option, the EasyBuilder creates a "Memory Utilization" window to display the memory usage information after finishing the "SAVE AS" operations.



Print Options    

This option allows you to select a style of data to be processed by Print option or by Print Preview option. A simple print option menu is popped up when you choose this option. There are four styles of data that you can select. It is shown in figure 2-3.

�

Fig. 2-3 print options

Hardcopy 

 select the contents of the current screen image.

Strings 

select all text strings used in text or message objects.

Graphic Files 

select all graphic files name used in graphic or graphic display format.

Formats 

select the formats summary



�� Print	

This option prints out data selected by Print Options.



Print Preview   

The option enables you to preview a printing draft of the selected data style without printing it out exactly.



Print Setup   

Under this option you can setup the printer driver suitable to your printer, change paper size and rotate paper orientation.



Exit 

Exits the EasyBuilder  .











�3. Object Design

�

Fig 3-1 :

 Object menu



Object menu

The Object menu is to create display and touch control objects. The menu is depicted in fig.3-1. It includes the following options : 

�SYMBOL 183 \f "Symbol" \s 10 \h�	Select Object : select an existing object

�SYMBOL 183 \f "Symbol" \s 10 \h�	Line : draw a line

�SYMBOL 183 \f "Symbol" \s 10 \h�	Rectangle : draw a rectangle

�SYMBOL 183 \f "Symbol" \s 10 \h�	Circle : draw a circle 

�SYMBOL 183 \f "Symbol" \s 10 \h�	Text : input a text string

�SYMBOL 183 \f "Symbol" \s 10 \h�	Graphics : import a bit map graphics 

�SYMBOL 183 \f "Symbol" \s 10 \h�	Date : display date

�SYMBOL 183 \f "Symbol" \s 10 \h�	Time : display time

�SYMBOL 183 \f "Symbol" \s 10 \h�	Lamp : mark a blinking area.

�SYMBOL 183 \f "Symbol" \s 10 \h�   Data : display current value of a specific PLC register or relay.

�SYMBOL 183 \f "Symbol" \s 10 \h�  Animation : create an graphics moving on the screen.

�SYMBOL 183 \f "Symbol" \s 10 \h�  Push Button : set a touch cell, when activated, writes data into PLC register or relay .

�SYMBOL 183 \f "Symbol" \s 10 \h� Screen Button : set a touch cell, when activated, switches the screen to display another page.

�SYMBOL 183 \f "Symbol" \s 10 \h�  File Button : set a touch cell, when activated, transports the file between the PLC and EasyView. 

�SYMBOL 183 \f "Symbol" \s 10 \h� Hardcopy : set a touch cell, when activated, prints out the screen image.

Tool box

�EMBED MSDraw   \* mergeformat���

Fig. 3-2:  tool box

The EasyBuilder  provides a fast way to select options in Object menu. There is a icon in the Tool box for each options as shown in fig.3-2. You can enable or disable the tool box by selecting the Tool box option in View menu.

�� Select Object  

The procedure to select an object on the screen is described as follows:

1) Click left on the select object icon, then move the cursor by mouse to point at the object that you want to select and click left again

2) There are four(or two) small painted boxes appear in each rectangular corner of the selected object ,the status line shows the type of selected object. 





�

�

Fig.3-3 : select object



3)You can then use the �copy�, �paste� and �delete� options in the Edit menu to copy or delete objects, or just drag the mouse to move the objects, or click � in the tool bar to call up the dialog box of the object.



If there are several objects at the pointed position, the EasyBuilder arranges these objects in order and selects the first one automatically. Objects belongs to different types are sequenced in the following order: 

line, rectangle, circle, text, graphics, date, time, lamp, data, animation, 

push button, screen button, file button, hardcopy. 

If there are several objects of the same type, they are arranged in the sequence of first add first select. Click mouse enable you to switch the current selection to next object in the sorting sequence. By this way, you can select any overlap object easily.



You can also select multiple objects simultaneously, press the left button of mouse and drag a dash rectangular box to cover all the target objects, release the left button of mouse, there are four(or two) small painted boxes appear in each rectangular corner of the selected objects, then just drag the mouse to move the objects.



�

� Line         

Use this option to draw a line. Each line represents one Line object.

To draw a line on the screen, perform the following steps: 

1)	Choose the Line option in the Object menu or click left on the Line  icon at tool box.

2)	Move the cursor to the start position of the line you want to draw.

3)	Drag the cursor to the end position of the line.

4)	Release the left button of mouse, the line object is built up.



Your can then select the line object and delete, duplicate or move it.

�

Fig.3-4 draw line, rectangle and circle



� Rectangle	      

Use this option to draw a rectangle. Each rectangle represents one rectangle object. To draw a rectangle on the screen, perform the following steps: 

1)	Choose the Rectangle option in the Object menu or click left on the Rectangle  icon at tool box.

2)	Move the cursor to an arbitrary corner of the rectangle where you want to draw.

3)	Drag the cursor to the diagonal corner of this rectangle.

4)	Release the left button of mouse, the line object is built up.



Your can then select the rectangle object and delete, duplicate or move it.



�� Circle	

Use this option to draw a circle. Each circle represents one circle object. To draw a circle on the screen, perform the following steps: 

1)	Choose the Circle option in the Object menu or click left on the Circle  icon at tool box.

2)	Move the cursor to an arbitrary corner of the square rectangle which is tangent to the circle you want to draw.

3)	Drag the cursor to the diagonal corner of this circle.

4)	Release the left button of mouse, the circle object is built up.



Your can then select the circle object and delete, duplicate or move it.



� Text	

Use the option to create a text string. Each text string represents one text object. The EasyBuilder supports both 15×8 fonts and 24×16 fonts, both fonts can be amplified 2 multiples to 4 mutiples. Each text object displays one line of text or a text file.



To create a text object on the screen, follow these steps : 

�

Fig.3-5 : the text object dialog

1)	Choose the Text option in the Object menu or click on the Text icon at tool box, move the cursor to up-left corner of the text string and click  left, the text dialog as shown in fig.3-5 is popped up.



2) Put the cursor bar at Text option, click left and input the text string that you want to display.

3) Select proper options for this text object.

4) Click on the OK button to create it or click on the Cancel button to cancel this operation without creating any object.

5) The text string appears at the cursor position.



�SYMBOL 183 \f "Symbol" \s 10 \h�	Text  : 

All characters in the option will be displayed on the screen.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Font :

There are two type of fonts (15×8 or 24×16)  can be selected.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Size :

You can choose to amplify texts in 1, 2, 3, or 4 multiples. 

�SYMBOL 183 \f "Symbol" \s 10 \h�	Reverse :

If you mark this option, texts are displayed in reverse color like  � .

�SYMBOL 183 \f "Symbol" \s 10 \h�	Text File :

EasyBuilder is able to import a complete text file into the screen. Use this option to import a text file to the EasyBuilder . Mark the �text file� option and fill in text file name or use �browse� button to select the right text file, the whole text file will display at the cursor position.

 

�

Fig. 3-6 import a text file



The length of the text can not be over than the maximum screen width of EasyView( 640 pixels for MT300 and 320 pixels for MT200). Therefore, the font option and size option that you select decide the maximum number of characters in a line. 



For example : Considering the MT300, with 15×8 font and 1 multiple size, each line can accommodate 80 characters, with 24×16 font and 1 multiple size, each line can accommodate 40 characters at maximum.



All these options of a text object can be modified again by selecting it and click � in the tool bar. 



�� Graphics 	

Use this option to import bit map graphics from other graphic package. The

EasyBuilder can display graphic files in BMP or PUT format. The size of each image file must be less than 640×400 pixels(32k bytes). Otherwise, The EasyBuilder will reject it. Besides the size limitation, these bit map graphic files must be in monochrome mode or 16 color mode. 



You can use "paintbrush" software supported by windows to create a BMP graphic file. The simplified steps to create a BMP file by paintbrush are described as following : 

1)	Execute the paintbrush software and draw the graphics.

2)	Click  on the select icon  � at the tool bar. 

3)	Move the cursor to the left top corner of the graphics, drag the cursor to cover the whole graphics, a dash line box appear around the graphics.

4)	Select the Copy to option in the Edit menu.

5)	Fill in graphic file name, select the file format as  single color  or 16 color.

7)	Click on the OK button to save the graphics to the file.

The details of how to use paintbrush are not illustrated here. You can use the on-line help of paintbrush or refer to other documents about paintbrush.



To create a graphic object on the screen, perform following steps : 

1)	Choose the Graphic option in the Object menu or click on the Graphic icon at tool box, move the cursor to up-left corner of the graphics, click left then a dialog box as fig. 3-7 is popped up.



�

Fig. 3-7 : the graphic object dialog



2)	Select the filename of the desired graphics that you want to display. The graphics shown in preview window help you identify the right one.

3)	Click on the OK button to create it or click on the Cancel button to cancel this operation without creating any object. 

4) The graphics appear at the cursor position.



The Library option and the Use Default option in the dialog provide another way to chose a graphic file.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Library option : 

This option enables you to gather the common use graphics in a library. Those graphic files must be put under the working directory of the EasyBuilder (i.e.\EasyView). Whenever you click on the Library icon, a Graphic Library dialog as fig.3-8 is popped up. The left side window show the list of graphics in the library. The Preview area at the right side displays the graphics that you select as a default.



�

Fig.3-8 : the Graphic Library dialog



Use the Append, Delete, and Modify in the Graphic Library dialog, you can easily add an graphic file into the library, delete any one from it, or modify any one in the list. You can write a comment up to 16 characters corresponding to each file to make a simple explanation. The popped up dialog of Append option and Modify option is depict in fig.3-9.



�

Fig.3-9 :  Library element dialog

�SYMBOL 183 \f "Symbol" \s 10 \h� Use Default  : 

This option displays the selected default graphics directly. The default graphics is selected in the Graphic Library dialog.



All these options of a graphics object can be modified again by selecting it and click � in the tool bar. 



� Date	 (for MT300 only)

The option creates a date object that displays current date of the real time clock of EasyView ( 95/06/12 ). The date is displayed in 24×16 fonts. 

Follow the following steps to create it : 

1)	Choose the Date option in Objects menu or click on the Date icon at  tool box. 

2) Move the cursor to the right position, click left again, a date symbol appears and a date object is created.



� Time (for MT300 only)	

The option create a time object that displays current time of the real time clock of EasyView ( 23:10:10 ). The time is displayed in 24×16 fonts. 

Follow the following steps to create it : 

1)	Choose the Time option in Objects menu or click on the Time icon at  tool box. 

2) Move the cursor to the right position, click left again, a time symbol appears and a time object is created.



�� Lamp (for MT300 only)	

Use this option to create a lamp object that marks a blinking region on the screen. All static objects (including line, rectangle, circle, text, and bit-mapped graphic objects) in the region get into twinkle when the corresponding PLC control device (a relay) gets ON(value = 1). The twinkle means it appear for half second and disappear for another half second.



�EMBED MSDraw   \* mergeformat���It is noted that if there is any data object in the blinking region, the display device of the data object must be the same as the control device of the lamp object. Otherwise, the data object in the blinking region may be blinking  irregularly 

.
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�Follow the following steps to create a lamp object : 

1)	Choose the Lamp option in Object menu or click on the Lamp icon at  tool box.

2)	Move the cursor to any corner of the rectangular region where you want to set the lamp object.

3)	Drag a dash line rectangular region.

4)	Release the left button of mouse. The Lamp Object Dialog is popped up  as shown in fig.3-10.



�

Fig. 3-10 : the Lamp Object Dialog



5)	Assign a PLC relay as the control device.

     The address assignment are different in different types of PLC. Please refer to the chapter The Types of PLC.

6)	Click on the OK button. A lamp object is created and is displayed as a dash rectangle on the screen, as depicted in fig.3-11.



�

Fig. 3-11 : a  Lamp object



After a lamp object is created, it can be moved, deleted, duplicated or modified again. The modification means to change the control device instead of changing the blinking region. If you want to change the blinking region, you have to delete the lamp object and to create it again.



�� Data	

Use this option to create a data object that displays current reading value of the PLC relay or register. These data displays according to the format assigned to the data object. The display formats include numeric, ASCII, filename, vertical bar graph, horizontal bar graph, texts and graphics.



The speed of  data refresh on the screen depends on the following facts :

�SYMBOL 183 \f "Symbol" \s 10 \h�	The amount of PLC data on the current screen.

�SYMBOL 183 \f "Symbol" \s 10 \h�	The continuity of the PLC data on the current screen.

�SYMBOL 183 \f "Symbol" \s 10 \h�	The response time of  PLC

�SYMBOL 183 \f "Symbol" \s 10 \h�	The display format assigned to these data object



The EasyView uses dynamic data access approach to manage data. You can access any PLC relay or register data, only those PLC data defined at the current screen will be accessed at the same time. It is better off to access a continuous block of PLC data in each page. Taking for an example, the data on the screen including M8, M9, M10 .. M15, D20, D21, D22, D23...D30 are continuous. The system automatically compiles a variable scan list for each display page optimized for PLC communication. i.e. the MT300 collects continuous PLC data in an read command to raise the communication efficiency. You don't have to worry about how to manage data. The continuity of PLC data on the same page would optimize the communication efficiency and speed up the data update speed on the screen.



To create a data object, follow the following steps : 

1)	Choose the Data option in Object menu or click on the Data icon at tool box.

2)	Move the cursor to left top corner of the position where you want to display data on it.

3)	Click left, the Data Object Dialog as shown in fig. 3-12 is popped up.



�

Fig. 3-12 : Data Object Dialog 

4)	In Display Device option, fill in the address of the PLC relay or register that its data are to be displayed. Also assign the display format in the Display Format dialog. You may use View Formats button to browse the format library and select an appropriate format number.

5)	Click on the OK button to create the data object.



�SYMBOL 183 \f "Symbol" \s 10 \h�	Display Device :

This option specifies the address of a PLC device that its data is to be displayed.  Refer to the chapter The Types of PLC to get the details about address assignment for different type of PLC. 

�SYMBOL 183 \f "Symbol" \s 10 \h�	Display Format  :

The option specifies a predefined format for the data object. The number of the format can be from 0 to 255. It must be a well-defined format. The details about how to define formats are introduced in the section Format  of chapter  Edit.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Blink  :

This option is applicable for MT200 and MT250 only. 

Setting a data object of PLC relay. If the display format is graphic or text, it is possible to control blinking of the graphic or text by another PLC relay.



 � EMBED PBrush  ���



As the above setting, display format 10 is a graphic display format, state number =2, state graphics = but1, but2.



PLC relay M10 control display graphics(i.e. when M10=0 it displays but1.bmp, when M10=1 it displays but2.bmp). If the blink field is mark (V), the next PLC relay(M11) control the blinking state, when M11=1 the state graphics will blinking in 1/2 sec. ON and 1/2 sec. OFF.



Since the EasyView access data in word oriented, therefore if the PLC relay is the last bit in the word, it is not possible to set blinking in this case.





Modifications of the content in dialog can be made after selecting the object and click � in the tool bar, refer to the section Select Object.



� Animation	

Use this option to create an animation object that controls the movement of a graphics in X-Y direction. If the control device is a double word device(DL), it controls the movement of graphics in X-Y direction. The low address register controls the operation in X direction, while the high address register controls the operation in Y direction. If the control device is a single word device(D), it controls the movement of graphics in X direction only. For example, the control device is DL10, then the register D10 controls the movement in X-direction and the register D11 controls the movement in Y-direction. The value in each registers decides the distance from original in pixels.
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Perform the following steps to create an animation object:

1)	Choose the Animation option in Object menu or click on the Animation  icon at tool box.

2)	Move the cursor to the left top corner of the desired animation region.

3)	Drag the cursor to the diagonal corner of animation region.

4)	Release the mouse button, the Animation Object Dialog as shown in fig.    3-13 is popped up.



�

Fig. 3-13 : Animation Object Dialog



5)	Assign proper registers to control animation in the Control Device option.

6)	Input the name of graphics file to be displayed in the animation or use browse to select one.

7)	Click on the OK button. An animation objects is created and displayed as shown in figure 3-14.

�

Figure 3-14 : an  Animation object



�SYMBOL 183 \f "Symbol" \s 10 \h�	Control Device  : 

Set the address of the register that controls the operation of animation. 



�SYMBOL 183 \f "Symbol" \s 10 \h�	Graphic Name : 

Set the file name of the graphics to be displayed on the animation. It�s a good practice to put the animation file under the directory �Animation graphics�(see Directories of the Chapter Tools). You can input the filename directly or browse the files under the working directory by clicking on the Browse button.



After an animation object is created, the animation region can not be modified. Modifications of the content in dialog can be made after select the object and click � in the tool bar, refer to the section Select Object.



� Push Button	

Use this option to create a push button object. The push button object specifies a rectangular region on the screen. Whenever the region is touched, the system writes a new value to the corresponding PLC address. 



There are several button types available, includes Momentary(MOM), Alternative(ALT), Numeric(NUM), Jog plus 1(JOG+), Jog minus 1 (JOG-) and Temporary filename select(FILE).



�

Fig. 3-15 : Push Button Dialog

�SYMBOL 183 \f "Symbol" \s 10 \h�	Write Device : 

Set the address of the PLC relay or register that new value is written to.



�SYMBOL 183 \f "Symbol" \s 10 \h�	Button Type  : 

There are several types of the button provided in the option :

�SYMBOL 216 \f "Wingdings" \s 10 \h�	MOM button 

When touch down, the EasyView sends a command to the PLC to energize the relay. The EasyView sends another command to de-energize the relay when touch up.

�SYMBOL 216 \f "Wingdings" \s 10 \h�	ALT button 

When it is touched, The EasyView sends a command to the PLC to write an value of the opposite state (ON -> OFF ; OFF -> ON) to the PLC relay.

�SYMBOL 216 \f "Wingdings" \s 10 \h�	NUM button 

When it is touched, a numeric keypad is displayed at the right bottom area of screen. Key-in the new value and press ENT, The EasyView sends a command to the PLC to write the new value to the PLC register.

�SYMBOL 216 \f "Wingdings" \s 10 \h�	JOG+ button 

When it is touched, The EasyView sends a command to the PLC to add 1 to the current value in the corresponding register. If the current value in register is the maximum limit, it is set to be the minimum limit.

�SYMBOL 216 \f "Wingdings" \s 10 \h�	JOG- button 

When it is touched, The EasyView sends a command to the PLC to minus 1 to the current value in the corresponding register. If the current value in register is the minimum limit, it is set to be the maximum limit.

�SYMBOL 216 \f "Wingdings" \s 10 \h�	FILE  button (N/A for MT200) 

When it is touched, a list of the temporary files is displayed at the right button area of screen. Select a proper temporary file from the list and press ENT. The EasyView sends a command to PLC to write the  corresponding file number to the PLC register.



�SYMBOL 183 \f "Symbol" \s 10 \h�	Range Format  : 

Assign a range format number to set the high and low limit of the valid input range. The format corresponding to this number must be predefined . For a NUM type button, the range limits the number to be written into PLC register. For JOG+/JOG- type buttons, the range limits the upper bound and the lower bound of the value. See Format section for details.



To create a push button object, follow the steps : 



1)	Choose the Push Button option in Object menu or click on the Push Button icon at tool box.

2)	Move the cursor to the left top corner of the push button.

3)	Drag the cursor to the diagonal corner of the push button.

4)	Release the mouse button. The Push Button Dialog as shown in fig, 3-15 is popped up.

5)	Assign proper selection to each options.

6)	Click on the OK button. A push button object is created and displayed as show in fig.3-16. A complete push button shall includes two objects, one data object and one push button object, both objects refer to the same PLC address.
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Fig. 3-16 :  Push Button object

All options in the Push Button dialog are allowed to be modified again, but the marked region for the push button is fixed. If you want to change it, delete the object and recreate it again.



� Screen Button         

Use this option to create a screen button object. The screen button object define a rectangular region on the screen. Whenever the region is touched, the EasyView displays the predefined page(GOTO selection)or the last saved page on the screen(by RETURN selection).
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Fig. 3-17 :  Screen Button dialog

�SYMBOL 183 \f "Symbol" \s 10 \h�	Screen : 

     There are two selections in the Screen option, i.e. GOTO and RETURN.

�SYMBOL 216 \f "Wingdings" \s 10 \h�	GOTO : 

The screen switches to the predefined page when this screen button is touched. The page option must be filled in the destination page number.

�SYMBOL 216 \f "Wingdings" \s 10 \h�	RETURN : 

The screen switch to the last saved page when this screen button is touched. Under this option, the page option is ignored.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Save :

Select whether to store current page number into memory or not. 

�SYMBOL 216 \f "Wingdings" \s 10 \h�	Yes : 

Store the current page number into memory before the screen switches. This operation makes current page to be a target page when the next screen button is pressed with RETURN option.

�SYMBOL 216 \f "Wingdings" \s 10 \h�	No : 

Switch the screen and do not update the last saved page number.



�SYMBOL 183 \f "Symbol" \s 10 \h�	Page No. -> PLC  :

Select whether to write the destination page number into a specified  PLC register or not. 

�SYMBOL 216 \f "Wingdings" \s 10 \h�	Yes : 

Write the page number to the PLC register specified by the Write Device option.

�SYMBOL 216 \f "Wingdings" \s 10 \h�	No : 

Switch the screen and do not write page number to PLC register. Under this selection, the Write Device option is ignored.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Write Device :

If Page No. -> PLC option is Yes, specify the PLC register to be written in the destination page number.



To create a screen button object, follow the steps : 

1)	Choose the Screen Button option in Object menu or click on the Screen Button  icon at tool box.

2)	Move the cursor to the left top corner of the screen button.

3)	Drag the cursor to the diagonal corner of the screen button.

4)	Release the mouse button. A Screen Button Object Dialog as fig. 3-17 is popped up.

5)	Assign proper options in each dialog according to previous descriptions.

6)	Click on the OK button. A screen button object is created and displayed as shown in figure 3-18.
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Fig.3-18 : a screen Button object



All options in the Screen Button Dialog are allowed to be modified. But the marked region for this button is fixed. If you want to change it, delete the object and create it again.



�� File Button (for MT300 only)	

Use this option  to create a file button object. The file button object define a rectangular region on the screen. Whenever the region is touched, the system transmit the temporal file(selected by operator) to a block of PLC registers or to read a block of PLC registers back to the temporal file(selected by operator).



�

Fig. 3-19 : File Button dialog



�SYMBOL 183 \f "Symbol" \s 10 \h�	Write Device: 

Define the start address of a block of PLC registers where to transmit data to. The block size of these PLC registers depends on the capacity defined in each temporal file(see section temporal file). For examples, the start address of registers is 100. The capacity of the temporal file are 100 words. Then the system will transmit temporal file data to the PLC registers D100 to D199.



�SYMBOL 183 \f "Symbol" \s 10 \h�	File Selector : 

Choose the method to select a temporal file at online operation.

�SYMBOL 216 \f "Wingdings" \s 10 \h�	NUM : pop up a numerical keypad to input the number of �		      temporal file.

�SYMBOL 216 \f "Wingdings" \s 10 \h�	LIST	 :  pop up a list of temporal files to select one from them.



�SYMBOL 183 \f "Symbol" \s 10 \h�	Direction: 

 define the file transport direction.

�SYMBOL 216 \f "Wingdings" \s 10 \h�	->PLC : transmit data from temporal file to PLC registers. 

�SYMBOL 216 \f "Wingdings" \s 10 \h�	<-PLC : transmits data from PLC registers to temporal file. 



To create a file button, follow the following steps : 

1)	Choose the File Button option in Object menu or click on the File Button  icon at tool box.

2)	Move the curosr to the left top corner of the file button.

3)	Drag the cursor to the diagonal corner of the file button.

4)	Release the mouse button. The File Button Object Dialog as shown in  fig. 3-19 is popped up.

5)	Assign proper options in each dialog according to previous descriptions.

6)	Click on the  OK button. A file button object is created and displayed as shown in fig. 3-20.
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Fig. 3-20 : an example of a File Button



All options in the File Button dialog are allowed to be modified. But the marked region for this button is fixed. If you want to change it, delete the object and create it again.



� Hardcopy Button	(for MT300 only)

Use this option create an hardcopy object. The hardcopy button object define a rectangular region on the screen. Whenever the region is touched, the EasyView transmits current screen image to printer to print them out.

The printer connected to EasyView must be compatible with ESC/P2 commands,(for examples, EPSON LQ-570+ printer). Otherwise, it cannot works correctly.



To create a hardcopy button, follow the following steps : 

1)	Choose the Hardcopy Button option in Object menu or click on the Hardcopy Button  icon at tool box.

2)	Move the cursor to the left top corner of the hardcopy button.

3)	Drag the cursor to the diagonal corner of the hardcopy button.

4)	Release the button of mouse. A hardcopy button object is created and displayed as shown in fig. 3-21.
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Fig. 3-21 : an example of a Hardcopy Button

�� PLC Control	

Use this option to create a PLC control object.  The PLC control object activates a specific operation whenever the corresponding control device is triggered. The PLC control objects is classified into four types:

�SYMBOL 183 \f "Symbol" \s 10 \h�	Screen switch 

�SYMBOL 183 \f "Symbol" \s 10 \h�	Screen hardcopy 

�SYMBOL 183 \f "Symbol" \s 10 \h�	File transport (between PLC and EasyView) 

�SYMBOL 183 \f "Symbol" \s 10 \h�	LCD Back light power control 



The PLC control object is usually defined in the common page(page 0) unless special consideration. In this way, whichever page is displayed on the screen, the PLC control object activates the specific operation whenever the control device is triggered.



It is recommended that you designate a continuous block of PLC registers or relays as the control devices. In such way, it makes the PLC control objects respond fast without affecting the screen update speed.



For examples, if you use D0, D1, D3, D4 and D5 registers as control register, it is better off to rearrange it as D0, D1, D2, D3 and D4. Regarding the bit device(relay), it is better off to take full use of those bit devices in the whole word unit, since the EasyView retrieves PLC relay data in the unit of word. For examples, if you use M15, M16, M17, M40, M41 and M42, it is better off to pack them as M15, M16, M17, M18, M19 and M20.

 

�

Fig. 3-22 : the PLC Control Object Summary



To create a PLC control object, follow the following steps : 

1)	Choose the PLC Control option in Edit menu or click on the PLC Control icon at tool bar. A PLC Control Object Summary window is popped up as show in fig. 3-22.

2)	Click on the Append icon to create a new PLC control object or click on the Modify icon to modify an existing PLC control object. A PLC control object dialog as shown in 3-23 is popped up. If you click on the Delete icon, the current pointed object is deleted.

3)	Assign proper options in the PLC control object dialog and click on the OK button to create the object and exit the PLC control object dialog. 

4)	Click on the OK button to exit the PLC Control Object summary.



�

Fig.3-23 :  PLC Control Object dialog



�SYMBOL 183 \f "Symbol" \s 10 \h�	Control Type : 

Assign the operation activated by this object. There are four selections in the dialog : Screen, Hardcopy, File Transport, Backlight.

�     (note: Hardcopy and File Transport are applicable for MT300 only)

�SYMBOL 183 \f "Symbol" \s 10 \h� Control Device  : 

Assign the address of PLC control device, it can be a PLC register or relay.







�SYMBOL 110 \f "Wingdings" \s 14 \h� Screen switch operation



�SYMBOL 216 \f "Wingdings" \s 10 \h�	Control Type : 

Select Screen switch operation.



�SYMBOL 216 \f "Wingdings" \s 10 \h�	Control Device : 

If you designate a word device as the control device, such as  D register, the destined page is decided by the register content. Whenever the value in the register gets nonzero, the EasyView takes the value as the destined page number and switches the screen to display the page, then it writes zero into the register if RESET option is set.

If you designate a bit device as the control device, such as M relay, the destined page is decided by the Screen and Page No. options. Whenever the bit device gets ON, the EasyView switches the screen to display the destined page, then it reset the bit device if RESET option is set.



�SYMBOL 216 \f "Wingdings" \s 10 \h�	Screen  : 

GOTO : designate Page No. as destined page.

RETURN : designate the last page number saved as destined page.



�SYMBOL 216 \f "Wingdings" \s 10 \h�	Page No.  : 

Fill in a page number(1~255) if Bit device and GOTO is selected.



�SYMBOL 216 \f "Wingdings" \s 10 \h�	Save :

Set it to save the current page into the internal memory when performing screen switch operation. It makes the current page as the destined page whenever a screen switch operation of RETURN option is specified.



【Example】

Use PLC internal relay M20 to control the switch screen operation. The  options are setup as shown in fig. 3-24.



�

Fig. 3-24 : Bit device switch screen operation



Whenever the M100 relay gets ON, the screen switches to display page 30 and the M100 relay is reset. 



【Example】

Use PLC register D50 to control the switch screen operation. The options are setup as  shown in figure 3-25.
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Fig. 3-25 : word device switch screen operation

Whenever the content in PLC register D50 gets nonzero, such as D50 = 25, the screen switches to display page 25 and the D50 is reset to zero.



�SYMBOL 110 \f "Wingdings" \s 14 \h� Screen hardcopy operation (for MT300 only)



�SYMBOL 216 \f "Wingdings" \s 10 \h�	Control Type : 

Select Hardcopy operation.



�SYMBOL 216 \f "Wingdings" \s 10 \h�	Control Device : 

If you designate a word device as the control device, such as D register, the page to be printed is decided by the register content. Whenever the value in the register gets nonzero, the EasyView takes the value as the page number and switches the screen to display the page, then prints it out. After the printing job is finished, the screen is returned to the original page and the register is written to zero  if RESET option is set.

If you designate a bit device as the control device, such as M relay, the page to be printed is decided by the Page No. option. Whenever the bit device gets ON, the EasyView switches the screen to display the page and prints it out. After the printing job is done, it returns to the original page and resets the bit device if RESET option is set.



�SYMBOL 216 \f "Wingdings" \s 10 \h�	Page No.  : 

Fill in a page number(1~255) if Bit device is selected.

�【Example】

Use PLC register D60 to control the operation of hardcopy. The  options are setup as shown in fig.3-26.
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Fig. 3-26 word device hardcopy operation



Whenever the value in D60 gets nonzero, such as D60 = 30, the screen switches to display page 30 and it is printed out. After the printing job is finished, the screen is returned to the original page. Then D60 is written to zero.



【Example】

Use PLC relay M20 to control the operation of hardcopy. The options are setup as shown in fig.3-27.



�

Fig. 3-27 Bit device hardcopy operation



Whenever M20 gets ON, the screen switches to display page 10 and  it is printed out. Then M20 is reset.



�SYMBOL 110 \f "Wingdings" \s 14 \h� File transport operation (for MT300 only)



�SYMBOL 216 \f "Wingdings" \s 10 \h�	Control Type : 

Select File transport operation.



�SYMBOL 216 \f "Wingdings" \s 10 \h�	Control Device : 

If you designate a word device as the control device, such as D register, the file number is decided by the register content. Whenever the value in the register gets nonzero, the EasyView takes the value as the file number and transports data from the temporary file to the PLC registers or from the PLC registers to the temporary file. After the transport is done, the word device is written to zero if RESET option is set.

If you designate a bit device as the control device, such as M relay, the file number is decided by the File No. option. Whenever the bit device gets ON, the EasyView transports data from the temporary file to the PLC registers or from the PLC registers to the temporary file. After the transport is done, the bit device is reset if RESET option is set.



�SYMBOL 216 \f "Wingdings" \s 10 \h�	Write Device : 

the start address of a block of PLC registers where the EasyView transport file to.

�SYMBOL 216 \f "Wingdings" \s 10 \h�	File No.  : 

Fill in a file number(1~511) if Bit device is selected.

�SYMBOL 216 \f "Wingdings" \s 10 \h�	Direction  : 

Select the direction of transport. Select "->PLC" is to load data from the temporary file to the PLC registers and "<-PLC" is to save data from the PLC registers to the temporary file.



【Example】

Use the PLC relay M30 to control the operation of file transport. The  options are setup as shown in fig.3-28.
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Fig.3-28 Bit device file transport



Whenever M30 gets ON, the EasyView transports all the data of file no. 5 to the PLC registers start from D200. Then M20 is reset.



�【Example】

Use the PLC register D10 to control the operation of file transport. The  options are setup as shown in fig.3-29.



�

Fig. 3-29 Word device file transport



Whenever the value in D10 gets nonzero, such as D10 = 15, the EasyView takes this value and transports all the data of file No. 15 to the PLC registers start from D200. Then D10 is written to zero.



�SYMBOL 110 \f "Wingdings" \s 14 \h� Backlight control operation



�SYMBOL 216 \f "Wingdings" \s 10 \h�	Control Type  : 

Select Backlight control for this operation.

�SYMBOL 216 \f "Wingdings" \s 10 \h�	Control Device : 

designate a bit device for this operation. When the control device is switched from 1 to 0, the EasyView turns the backlight off. When the device is switched from 0 to 1, the EasyView turns the backlight on.
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During the period backlight is turned off, the EasyView turns the backlight on immediately whenever the screen is touched.

�� Message	

Use this option to create the message object. The message object activates the operation of printing or displaying a predefined text string, or both, whenever the corresponding control device is triggered(the value of the control device is nonzero).



It is noted that the printer connected to the EasyView must be compatible  with ESC/P2 commands(for example: EPSON LQ-570+ printer). Otherwise, it cannot work properly. If your EasyView is equipped with an internal clock, it prints out the date and time records accompanied with the message as shown below. 

96/03/10   10:11:12   Warning...

96/03/10   10:11:12   The safety door is not closed.

96/03/10   10:11:13   Temperature of the spillway is too high.



A message keeps to be displayed and rolled in the message window until the value of  control device becomes 0. If there are several messages activated at the same time, all these messages are displayed and rolled in the message  window one after another. It is shown as fig. 3-30.
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Fig. 3-30 the message window 

It is also noted that the message window is popped up per page configurable. You have to mark the option "message" under Overlap (in Edit menu) settings in order to display the message window. The message object shall be defined in the common page(page 0) unless special consideration. In this way, whichever page is displayed on the screen, the text string of message object is displayed or printed  whenever  its control device is triggered.



To create a message object, follow the following steps : 

1)	Choose the Message option in Edit menu or click on the Message  icon at tool bar. A Message Objects List window is popped up as fig.3-31.

�

Fig. 3-31 : the Message Objects List window

2)	Click on the Append icon to create a new message object or click on the Modify icon to modify an existed message object. A message object dialog as shown in fig. 3-32 is popped up. If you click on the Delete icon, the current pointed object is deleted.

3)	Assign proper options in the message object dialog and click on the OK to create the object. 

4)	Click on the OK to exit the Message Object List window.

�

Fig. 3-32 : message object dialog

�SYMBOL 183 \f "Symbol" \s 10 \h�	Control Device  : 

Assign a PLC internal relay to activate the message display and printing.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Message  : 

Input a text string be printed or displayed.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Display : 

Mark this option to enable the message display function.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Print  : (for MT300 only) 

Mark this option to enable the message printing function.

�Fig. 4-1 : Edit menu

4. Edit 



Click on the Edit  in the menu bar to pull down the Edit menu as fig. 4-1. The Edit  menu includes the following functions.

�SYMBOL 183 \f "Symbol" \s 10 \h� Format : define format libary.

�SYMBOL 183 \f "Symbol" \s 10 \h� Temporary File : define the filename and size of each temporary file. 

The functions of PLC control and message are described in the Object Designs chapter.





� Format 

Each project file can define at most 256 formats, it represents the style to display the PLC data or the range to limit data entry. These formats are divided into two classes : display formats and range formats. Each data object needs to designate a display format, the EasyView will display the PLC data based on the predefined display format. Please refer to the section Data Object in the chapter Object Designs. A push button object with type option of NUM or JOG+/- needs a range format to limit the range of data entry, please refer to the Push button section in the chapter Object Designs.



�SYMBOL 183 \f "Symbol" \s 10 \h�	Display formats : 

The PLC data can be displayed on the screen by using Data object with numeric, ASCII, filename, bar graph, text, or graphics style. For each style, you have to define a proper format before creating the data object. The EasyView provides the following display formats.



�SYMBOL 216 \f "Wingdings" \s 10 \h�	Numeric

�SYMBOL 216 \f "Wingdings" \s 10 \h�	ASCII

�SYMBOL 216 \f "Wingdings" \s 10 \h�	File Name

�SYMBOL 216 \f "Wingdings" \s 10 \h�	Bar Graph (Horizontal)

�SYMBOL 216 \f "Wingdings" \s 10 \h�	Bar Graph (Vertical)

�SYMBOL 216 \f "Wingdings" \s 10 \h�	Text

�SYMBOL 216 \f "Wingdings" \s 10 \h�	Graphics



��SYMBOL 183 \f "Symbol" \s 10 \h�	Range format : 

The range format set a bound of data entry. It is used by the push button object of NUM or JOG+/JOG- type.

�SYMBOL 216 \f "Wingdings" \s 10 \h�	In NUM type push button : limit the numeric data input range.

�SYMBOL 216 \f "Wingdings" \s 10 \h�	In JOG+/JOG- type push button : set the increasing upper bound and the decreasing lower bound

�

Fig. 4-2 : the Format Table 

To define a format, follow these steps : 

1) Choose the Format option in the Edit menu or click on the Format icon in tool bar. The Format Table as  fig. 4-2 is displayed.

�

       Fig. 4-3 :  Format dialog

2)	Move the cursor  to the format number which you want to define and click left.

3)	Click on the Setting button to create a format option dialog as shown in fig. 4-3.

4)	Assign proper options in the Format dialog and click on the OK button to define it.

5)	Repeat step 2 to step 4 to define other formats or click on the OK button to close the Format Table.

�Format type 

The Format type option is a general option for every format. It defines the attribute of each format. 



�SYMBOL 216 \f "Wingdings" \s 10 \h�	Numeric : 

It displays the PLC register data in numeric style. The corresponding options are depicted in fig.4-4. By these options, you assign the number of figures before and after the decimal point to be displayed. You can also chose to display these numeric in 15×8 fonts or 24×16 fonts and to amplify them 1 to 4 multiples. 



�

Fig.4-4 : Numeric format options



For example : Assign options as fig. 4-4. A number 1234 will be displayed as   123.4.  



�SYMBOL 216 \f "Wingdings" \s 10 \h�	ASCII : 

It displays the PLC register data in ASCII code directly. The corresponding options are depicted in figure 4-5. By these options, you assign the number of the ASCII characters to be displayed. It needs two characters space for a single word device. You can also chose to display these ASCII characters in 15×8 fonts or 24×16 fonts and to amplify them 1 to 4 multiples. 



�

Fig. 4-5 :  ASCII format options



The ASCII code stored in the lower byte is displayed at the left, and the other one stored in the higher byte is displayed at the right. For example : Assign options as fig. 4-7. The data 4241h will be displayed as "AB"



�SYMBOL 216 \f "Wingdings" \s 10 \h�	File Name : 

The File Name format uses the value accessed from the PLC registers as the temporary file number and displays the file name corresponding to this number. The file name to be displayed is not allowed to be larger than 14 characters. It is displayed in 15×8 fonts. The only option of the format is the amplified size ( 1 - 4 multiples).

�

Fig. 4-6 : options corresponding to File Name format



�SYMBOL 216 \f "Wingdings" \s 10 \h�	Bar Graph (V) : 

With this format, the accessed PLC register data is displayed in a vertical bar graph as shown in fig. 4-7.

�EMBED MSDraw   \* mergeformat���

 Fig. 4-7 : vertical bar graph



The options corresponding to the format are depicted in fig. 4-8. The Length and Width options set the length and width of the bar graph in pixels. The span and zero of the bar graph are assigned in the Max/Min options. If the Max larger than the Min, the bar graph grows from bottom to top. If the Max less than the Min, the bar graph grows from top to bottom.



�

Fig. 4-8 :  Vertical Bar Graph format options



�SYMBOL 216 \f "Wingdings" \s 10 \h�	Bar Graph (H) : 

With this format, the accessed PLC register data is displayed in a horizontal bar graph as fig. 4-9.
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Fig. 4-9 : horizontal bar graph

The options of this format are as same as those in Bar Graph (V) format. If the Max larger than the Min, the bar graph grows from left right. If the Max less than the Min, the bar graph grows from right to left.



�SYMBOL 216 \f "Wingdings" \s 10 \h�	Text : 

With this format, each text  string represents one of the PLC register data or relay states. According to the value accessed from the PLC device, the corresponding text string is displayed on the screen.

Options of this format are shown in fig. 4-11.



�

Fig 4-11 : Text format options

States  : 

The States option defines the number of states. The maximum number of states is 32.



Content  : 

The text strings which represent each state are filled in the Content option. Each text string is separated from others by commas. The length of each text string must be equal. All these text strings must be arranged in the sequence corresponding to the state value increased from 0. The maximum length of content is 160 characters including commas.



For example : 

assign options like fig.4-11. Then it displays "off" when the value accessed from PLC register is 0, and it displays " on" when the value is 1.



Font and Size: 

These two options define the character font and the amplified scale of the text to be displayed .



��SYMBOL 216 \f "Wingdings" \s 10 \h�	Graphics : 



Similar to the Text format, each graphic represents one of the PLC register data or relay states. According to the value accessed from the PLC device, the corresponding graphic is displayed on the screen.



Options corresponding to this format are similar to those in the text format. The No. of states are defined in the States option. The maximum number of states are 32. Instead of assigning text string, here we assign the filenames of these graphics corresponding to each state in Content  option. Similarly, these filenames must also be arranged in sequence and separated with commas. The extension name is not needed to be specified in Content option. It is already specified by the Graphic Type option.

�

Fig. 4-12 Graphic format
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The Graphic Type option selects the bit map file format. The EasyBuilder supports the BMP and PUT format. All files specified in the Content must belong to the same type. It is noted that all the specified files must be located in the �animation graphics� directory specified by �directories� option of �tool� menu.



In the MT200/250, when the number of state = 1 and the reading value =1,  it will display the graphic in blinking.



��SYMBOL 216 \f "Wingdings" \s 10 \h�	Range : 

The format sets boundary of push button of NUM or  JOG+/JOG- type.



Options corresponding to this format are the maximum value and the minimum value as fig. 4-13.



�

Fig. 4-13 : Range format options



For a NUM type push button, the format limits only the numbers within its range can be accepted. For instance, set a range format as fig.4-13 and designate it to a push button object of NUM type. Accordingly only the numbers from 1 to 1000 can be written into the corresponding registers.



For a JOG+/JOG- type push button, the format sets the increasing upper bound and the decreasing lower bound. For example, the lower bound is 1 and the upper bound is 5. The JOG+ push button will vary register data as  ...1 -> 2 -> 3 -> 4 -> 5 -> 1 -> 2 ... The JOG- push button will vary register data  ... 3-> 2 -> 1 -> 5 -> 4 -> 3...



��Temporary File (for MT300 only)  	

The function lets you create temporary files used in file transport. 

There are 512 temporary files at maximum in the EasyView. The size of each temporary file can be set to be from 1 to 255 words. The total capacity of all temporary files is 24,576 words (24k words) at maximum. Each temporary file can be assigned a file name with the maximum of 14 characters. 



Perform the following steps to create the temporary files:

1)	Choose the Temporary File in Edit menu or click on the Temporary File icon in the tool bar. A Temporary File Summary as fig.4-14 is popped up.

2)	Move the cursor to the file number which you want to create a temporary file and click.

3)	Click on the Modify button to pop up the Temporary File dialog.

4)	Assign the size of the temporary file in the Capacity dialog with the unit of word. The maximum capacity of a temporary file is 256 (0-255) words.

5)	Input the file name of the temporary file in the File Name option. The maximum length of the filename is 14 characters. 

6)	Click on the OK button to define the temporary file.

7)	Repeat step 2 to step 6 to define each temporary file.

8)	 Click on the OK button in Temporary File List window to close it.�
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Fig. 4-14 : Temporary File List



�

Fig. 4-15: Temporary File dialog











These created temporary files are loaded or saved by File Transport object or PLC Control object. Please refer to the sections File Button or PLC Control  in the chapter Object Designs.



Fig.5-1

Tool Menu

5. Tool 

�



Click on the Tool  in the menu bar to pull down the Tool menu as fig. 5-1. The Tool  menu includes the following functions.

�SYMBOL 183 \f "Symbol" \s 10 \h� Overlap : set overlap page and enable message window display of each page.

�SYMBOL 183 \f "Symbol" \s 10 \h� Page cut : erase all objects in the current page.

�SYMBOL 183 \f "Symbol" \s 10 \h� Page copy : duplicate all objects from another page to the current page.

�SYMBOL 183 \f "Symbol" \s 10 \h� Directories : setup the directory for graphics/text files.



� Overlap	

This function lets you set overlap page and enable message window display of each pages (from 1 to 255). For the detail about the characteristics of an overlap page, refer to the section "General page, Overlap page, and the Common page" in chapter "Introduction."



To assign an overlap page, follow the following steps : 

1)	Choose the Overlap option in Tool menu or click on the Overlap  icon in toolbar. An Overlap table as figure 5-2 is popped up.



2)	Move the cursor to the page which you want to setup and click left.

�

Fig.5-3 Overlap dialog



�

Fig.5-2 : the Overlay table 







3)	Click on the Setting button. An Overlap dialog for the page is popped up as shown in fig. 5-3. 





�SYMBOL 216 \f "Wingdings" \s 10 \h�	Overlay :

Mark it to set an overlap page. De-mark it to cancel the existing overlap relation.



�SYMBOL 216 \f "Wingdings" \s 10 \h�	Overlap Page : 

Assign the overlap page for this page. 



�SYMBOL 216 \f "Wingdings" \s 10 \h�	Message: 

Mark it to enable a message window on this page. If you use a message object to display a specific message, you must mark this option that the message window may displays the messages.



4)	Choose the proper options in Overlap dialog and click on the OK button. The overlap relation of this page is built and displayed in the Overlap Table.



5)	Repeat step 2 to step 4 to set overlap of each page.





� Copy 	

The page copy function duplicates all the objects from another page to current page. All the original objects in the current page are erased concurrently. All display objects (including line, circle, rectangle, text, graphic, data, animation, and lamp objects) and touch control objects( including objects of push button, screen button, hardcopy button, and file transport button) in the source page are duplicated into current page. However the PLC control and the message objects shall not be duplicated into current page. 



Perform the following steps to copy all the objects from source page : 

�

Figure 5-5 :  Page Copy dialog

1)	Choose the Copy function in the Tool menu or click on the Copy icon at tool bar. The Page Copy dialog is popped as  fig. 5-5.

2)	Assign the source page number in the Page No option.

3)	If the source page is in the working file, select the Working File option in the Source Type dialog. Otherwise, select the Other File and fill the File Name option with source project file. If the Other File is selected, you can also use Browse button to choose a file.

 4) Click on the OK button to duplicate the page.



Since each Data or Push button objects refer to a format, the different definitions of formats in different files may cause confusion when a page is duplicated from another file. The EasyBuilder resolves this problem with the following rules. If the format corresponding to the duplicated object does not exist in the working file, the EasyBuilder duplicates it from the source file accompanied with the object. If the format has already defined in the working file, the EasyBuilder  keeps it without duplicating the one from the source file. It may cause the duplicated object to relate to an unsuitable format. You have to note this problem in executing this function.



� Cut	  

The page cut function erases all the objects in current page.

Perform the following steps to delete the objects in the whole page: 



1) Choose Cut option in the Tool menu or click on the cut icon at tool bar. A warning message is displayed and requests you to confirm it again.



�

Fig.5-4 : A warning message for page delete



2) Click on the "Y" button to confirm the operation or click on the "N" button to cancel it.



�Directories	

In order to provide an efficient way to manage the graphic files, EasyBuilder  allow each project create its own directory to store graphics and text files.



�



Static Graphics/Text: The EasyBuilder will search this directory for those graphics files referred by graphics objects , if it cannot find those graphics files at the original directory. It�s the same for those text files referred by text objects. 



Animation Graphics: The EasyBuilder will search this directory for those graphics files referred by graphics format and animation objects, if it cannot find those  graphics files at the original directory.



ASCII Fonts: This is the directory that ASCII pattern files is located, EasyBuilder requires both ASCFONT.15 and ASCFONT.24 files.



�6. View 



�



The View menu contains scaling functions that allow you to choose an appropriate way to display a page. The menu is depicted in fig. 6-1. It includes the following options : 



�SYMBOL 183 \f "Symbol" \s 10 \h�	100 ﹪: display screen in normal size

�SYMBOL 183 \f "Symbol" \s 10 \h�	75 ﹪: reduce the screen size to 75 ﹪

�SYMBOL 183 \f "Symbol" \s 10 \h�	Tool Bar : display the tool bar at the top of the screen

�SYMBOL 183 \f "Symbol" \s 10 \h�	Status Bar : display the status bar at the bottom of screen

Fig. 6-1 View Menu

�SYMBOL 183 \f "Symbol" \s 10 \h�	Tool Box : to pop up the tool box on the screen

�SYMBOL 183 \f "Symbol" \s 10 \h�	Graphics Files : display a list of the graphic files used in the working project

�SYMBOL 183 \f "Symbol" \s 10 \h�	Align Grid : force new added objects to be positioned on the grid

�SYMBOL 183 \f "Symbol" \s 10 \h�	Grid : display 8x8 grid covering the whole working area

�SYMBOL 183 \f "Symbol" \s 10 \h�	Object Contents : display the corresponding PLC device of each object

�SYMBOL 183 \f "Symbol" \s 10 \h�	Select Page No. : display the object summary at each page

100 ﹪ and 75 ﹪ 

These two options help you to display a page in proper scale. Either one of them is selected, the other one is deselected automatically.

Tool Bar 
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Fig. 6-2 Tool Bar



The option enables you to display the tool bar or not. To activate or deactivate the Tool Bar option, simply select it. A "�EMBED MSDraw   \* mergeformat���" symbol indicates that the option has been selected.

Status Bar 

The option enables you to display the status bar at the bottom of screen. A brief description corresponding to current operation is displayed on the status bar. As same as the Tool Bar option, simply select the option to activate or deactivate it.

Tool Box 
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Fig. 6-3 Tool Box

This option activates the tool box to provide a fast way of creating objects. The tools box is arranged at the right bottom side on the screen after you select the option. To move it to arbitrary position, simply move the arrow cursor pointed on its headline and drag it. 

Graphic Files

The option display the list of graphic files used in the working file. It includes the graphic files used by Graphic object, Animation object and those referred to in formats.
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Fig. 6-4 : a list of graphic files

�Align Grid 

After this option is activated, new added objects or objects to be moved will be positioned on the grid.

Grid

This option displays grid in gray color on the working area . The size of the grid is 8×8 pixels.

Object Contents

As described in previous chapters, some dynamic objects , such as data object, lamp object, animation object, push button object or file transport object, correlate to a specific PLC relay or registers. To inspect those information, this option enables you to display these objects accompanied with its corresponding PLC device address. 



Several selections are provided under this option for different dynamic objects as shown in figure 6-5. These selections enable you to specify some specific types of dynamic objects to be displayed with its corresponding PLC device address.



�

Fig. 6-5 : the options under Object Contents
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Fig. 6-6 display PLC register on the screen

�Select Page No.

The �Select Page No.� option shows the objects details in each page. Choose �Select Page No.� at �View� menu, the fig.6-7 displays the  total number of objects in each page.

  

�

Fig. 6-7 Number of objects summary



Press � or � to select the right page, then click  �, the fig. 6-8 shows the number of each objects type in the page.

 

�

Fig.6-8 classified number of objects in a page��7. PLC device address naming style

The EasyView provides separate device drivers to link with most popular PLCs in the market. The available PLC drivers include OMROM, SIEMENS S7 200/300, A-B SLC, MITSUBISHI, FACON FB, MATSUSHITA FP, KOYO Direct, GOLDSTAR Master K, Sharp JW, HITACHI H ..etc. More device drivers are added every day. If you cannot find a device driver for your PLC, check technical support person of our agent. 



�

Fig. 7-1 : the PLC type selective dialog at tool bar

The names and the addressing style of devices in different types of PLC are usually different. After you open a project file in the EasyBuilder, you must select the proper type of your PLC from the PLC TYPE selective dialog at tool bar. It is depicted in fig.7-1. This function makes the EasyBuilder  use the same register's name and address as those used in your PLC program. If you forget to select a proper PLC type when opening a new project, the device names and addressing method will different from those of your PLC.



�



�OMRON address Style

Name�Address�Range�� IR� dddbb� ddd: 0~255

  bb: 0~15�� HR� dddbb� 
as above
�� AR� dddbb� 
as above
�� LR� dddbb� 
as above
�� TC(PV)� ddd� ddd: 0~255�� DM� dddd� dddd:0~4095�� DL� dddd� dddd:0~4095��DL consists of two continuous DM.









MITSUBISHI FX address Style

Name�Address�Range�� X� ooo� ooo: 0~177

 (
Octal
)�� Y� ooo� 
as above
�� S� ddd� ddd: 0~999�� T� ddd� ddd: 0~255�� C� ddd� ddd: 0~255�� M� dddd�dddd: 0~1023�� TV(PV)� ddd� ddd: 0~255�� CV(PV)� ddd� ddd: 0~255�� D� ddd� ddd: 0~511�� DL� ddd� ddd: 0~511��DL consists of two continuous D. �



�MITSUBISHI AXX Address Style	

Name�Address�Range��X� hhh� hhh: 0~7FF��Y� hhh� hhh: 0~7FF��M� dddd� dddd:0~2047��T(PV)� ddd� ddd: 0~255��C(PV)� ddd� ddd: 0~255��D� dddd� dddd:0~1023��DL� dddd� dddd:0~1023��DL consists of two continuous D.





Matsushita FP Address Style

Name�Address�Range��X� ddh� dd: 0~99

 h : 0~F��Y� ddh� 
as above
��R� dddh� ddd: 0~255

  h : 0~F��TC� ddd� ddd: 0~999��SV� ddd� ddd: 0~999��EV� ddd� ddd: 0~999��DT� dddd� dddd:0~4095��DL� dddd� dddd:0~4095��DL consists of two continuous DT.



FACON FB address Style

Name�Address�Range��X� ddd� 0~159��Y� ddd� 0~159��M� dddd� 0~1399��RT� ddd� 0~255��RC� ddd� 0~199��RD� dddd� 0~4095��DL� dddd� 0~4095��DL consists of two continuous RD.







KOYO Direct Address Style

Name�Address�Range��I (X)� ooo� 0~477��Q (Y)� ooo� 0~477��M (C)� ooo� 0~377��T � ooo� 0~177��C (CT)� ooo� 0~177��R (V)� oooo� 0~7777��RL� oooo� 0~7777��All address is octal. RL consists of two continuous R.



Hitachi H Address Style

Name�Address�Range�� M� hhh� hhh: 000~FFF�� WM� hhh� hhh: 000~FFF�� TC� nnn� nnn: 0~511�� L� hhh� hhh: 000~FFF�� WL� hhh� hhh: 000~FFF�� R� hhh� hhh: 000~FFF�� WR� hhh� hhh: 000~FFF�� DR� hhh� hhh: 000~FFF��All address are hex-decimal except TC, DR consists of two continuous WR.



GoldStar Master-K address style

Name�Address�Range�� P� nnh� nn: 0~99

 h: 0~F�� M� nnh� nn: 0~99

 h: 0~F�� T� ddd� ddd:0~255�� C� ddd� ddd:0~255�� D� dddd� dddd:0~4095�� DL� dddd� dddd:0~4095��DL consists of two coninuous D.

�Allen-Bradley SLC address style

Name�Address�Range��I� dddh� ddd:0~255 

  h: 0~F��O� dddh� ddd:0~255

  h: 0~F��B� dddh� ddd:0~255

  h: 0~F��N� dddd� dddd:0~4095��NL� dddd� dddd:0~4095��C� dddb� ddd:0~255   

 b:0(PRE),

   1(ACC) ��T� dddb� dddd:0~255

 b:0(PRE),

   1(ACC) ��NL consists of two continuous N.







�Siemens S7 address style

Name�Address�Range��I� nnb� nn: 0~99

 b: 0~7 �� O� nnb� nn: 0~99

 b: 0~7 �� M� nnnb� nnn: 0~511

 b: 0~7 �� VW� dddd� dddd: 0,2,4,..

 must be even�� VD� dddd� dddd: 0,4,8,..

 must be 

 quadruplicate��VD consists of two continuous VW.

 N�s corresponding PLC address

File No.�N address��7�0~255��11�256~511��12�512~767��13�768~1023��14�1024~1279��15�1280~1535��16�1536~1791��17�1792~2047��18�2048~2303��19�2304~2559��20�2560~2815��21�2816~3071��22�3072~3327��23�3328~3583��24�3584~3839��25�3840~4095��



Sharp JW address style

Name�Address�Range�� R� oooo� 000~7777 �� TC� ooo� 000~777�� DM� oooo� 0000~7777�� DL � oooo� 0000~7777��Address is in octal, DL consists of two continuous DM.











���8. Download 

This chapter describes the operations to load a project file created by the EasyBuilder into the flash memory of EasyView . Remember to save the project file in the EasyBuilder  before you start to load project file. 



The load procedure is listed as follows:

1)	Connect the RS232 port of MT  to the COM1 or COM2 of PC.

2)	For MT300, set the switch SW8 =ON and set SW7 to select a transmission speed. 

    ON : 19200 baud rate

    OFF : 9600 baud rate

    for MT200/250 Set the switch SW8 =ON and set SW7 to select a transmission speed. 

    ON : 19200 baud rate

    OFF : 9600 baud rate

3)	Press the RESET button .

4) Execute the EasyView Download Utility, the screen will display as follows:
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Model: select the appropriate EasyView model (MT200/MT250/MT300)

PLC driver: select appropriate PLC type to connect with EasyView

User Project: fill in project name created by �EasyBuilder� editor software, or use browse function to select the project.

COM Port: select COM port(COM1 or COM2) of your PC to connect with EasyView.

Baud Rate: transmit speed between EasyView and PC, if the DIP SW7=ON of MT300 (or SW3=ON of MT200/250) select 19200, otherwise select 9600.



After fill in the above selection, press �OK� to start the download procedure.



Note: The MT300 is equipped with two flash memory for project data and driver separately, the MT200/250 is equipped with one flash memory for both project data and driver. Therefore the driver & project can be download separately by selecting �v� in the �load driver� and �load user project� field if the model is selected as �MT300�, while for MT200/250 the driver and project data must be download altogether .





�Appendix A : �Installation of the EasyBuilder software



To install the EasyBuilder software, perform the following steps : 



Under the windows environment, insert the EasyBuilder diskette into disk driver A and execute the command "A:\setup" to start the installation program. The dialog  box as fig.A-1 is popped up.
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Fig.A-1

Enter the directory you want to install  the EasyBuilder . Click on the OK button, the installation process will start. After the installation is completed, it builds up a EasyView group in windows and creates an icon of the EasyBuilder  in this group.
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Fig A-2





�

Appendix B : Examples to build objects

Create an ON/OFF push button

To create an ON/OFF push button, follow these steps : 

1)	Use paintbrush software � to create two graphics that represent ON and OFF states respectively.

The first is the graphic of OFF state. 

Name it as "BUT1.BMP".�

The second is the graphic of ON state.  

 Name it as "BUT2.BMP".�

2)	Start the EasyBuilder by clicking on the icon. �

3)	Select the Formats by clicking on the icon � to add a graphic display format.
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Fig. B-1

�

Fig. B-2
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Fig. B-3

4) Click on the data object icon �. Move the cursor to a desired position to create the data object then click, the data object dialog box is popped up as shown in Fig. B-3.
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Fill in PLC device address and display format number then click on the OK button. A data object is created and it is shown on the screen as Fig. B-4.
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Fig. B-5

5)	Click on the push button icon �. Move the arrow cursor to the left top corner of the data object. Drag a rectangle area to cover the data object. The rectangular area is the effective touch area of push button. Release the left button of mouse, the push button dialog box is popped up as Fig. B-5.





Fill in write device and button type then click on the OK button, a push button object is created and it is shown on the screen as Fig B-6.
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Fig. B-6

The ON/OFF push button is created. The rectangular area marked with dashed-line is the effective touch area of push button.

�Create a numeric data display

To create a numeric data display, follow these steps : 

�

Fig.B-7

1)	Select Formats by clicking on the icon � and add a numeric display format.



�

Fig. B-8

If you need to limit the input number within a range, set a range format as Fig B-8.

�

Fig. B-9













After the above setting, the format table is shown as Fig. B-9.
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Fig. B-10
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Fig. B-11

2)	Click on the data object icon � . Move the cursor to a desired position to create the numerical data, then click left. A data object dialog box is popped up. Fill in the PLC device address and display format then click on the OK button. A data object is created and it is displayed on the screen as Fig. B-11.

�
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Fig. B-12

3)	Click on the push button icon � . Move the cursor to the left top corner of the data object, drag a rectangle to cover the data object. The rectangular area is the effective touch area of  push button. Release the left button of mouse. A push button object dialog box is popped up.
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			Fig. B-13



Set Button type to "NUM". Click OK button. A push button object is created and it is displayed on the screen as Fig. B-13.







A numeric data is created. The rectangular area marked with dashed-line is the effective touch area of push button, A numerical keypad will be popped up when the effective area is touched.��Appendix C : Difference between 

MT200,MT250 and MT300



�MT300�MT250�MT200��Object type�����Date�optional�no�no��Time�optional�no�no��Lamp�yes�no�no��Hardcopy�yes�no�no��File button�optional�no�no��PLC control�yes�#1�#1��Message�yes�#2�#2��memory capacity

(graphics)�416K

(expandable to 928K)�288K�288K��Screen layout�640x480 dot�640x480 dot�320x240 dot��#1: PLC control object do not support hardcopy function.

#2: Message object do not support printout function.
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